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Introduction 
This guide is for K-12 authorized users of the Michigan Student Data System. The 
purpose of this guide is to offer a comprehensive overview of the process for 
uploading multiple requests for Unique Identification Codes. 

For additional guidance, refer to the MSDS District User Guide. 

While the Request for UIC collection does not have open and close dates, UICs are 
required data fields in other MSDS collections that do have deadlines. Please see 
the CEPI calendar for more information. 

  

https://www.michigan.gov/cepi/-/media/Project/Websites/cepi/MSDS/District_User_Guide.pdf
https://www.michigan.gov/cepi/calendar
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Overview 
This guide describes the process of uploading multiple students to the Request for 
UIC Collection in one file. To upload multiple students, student information must be 
converted to the Extensible Markup Language schema used for the collection. This 
involves the use of Microsoft Excel to produce an XML file. Students are added to an 
Excel spreadsheet and then uploaded to the collection. 

This guide breaks the bulk upload process into seven steps: 

1. Downloading the schema file 
2. Preparing the data file (in Microsoft Excel) 
3. Preparing the data file (using XML) 
4. Uploading the XML file to MSDS 
5. Checking the file upload status 
6. Recovering UIC assignment details 
7. Clearing staging data 

This guide is intended for non-college and non-university users, such as those 
who submit students for: 

• K-12 entities 
• Early Childhood entities (for more information on EC programs, please refer 

to the MSDS web page) 
• Adult education centers  

https://www.michigan.gov/cepi/pk-12/msds/early-childhood
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Step 1: Download the Request for UIC Schema File 

To begin obtaining UICs, student data must be uploaded in XML format. The 
template you will use is called a schema file. 

1. Go to the CEPI Request for UIC web page. 

2. At the bottom of the page, expand the “Technical Material” menu. 

 

3. Right-click “Request for UIC Schema.” Select “Save target as” (or “Save link 
as,” depending on your browser). 

4. Navigate to a directory to save the schema file. Give the file a name you will 
remember. 

5. Click Save to finish. 

  

https://www.michigan.gov/cepi/pk-12/msds/request-for-uic
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Step 2: Prepare the Data File 

This step uses Microsoft Excel to create a spreadsheet with your students’ data. You 
may also be able to prepare data files directly from your Student Information 
System. Because systems and data fields used differ between entities, CEPI cannot 
recommend a common export method. 

 

1. Enter your student data into the spreadsheet using the column layout 
and headers shown above. 

a. Cell A1: Student Last Name 

i. This field is required and cannot be blank. 

ii. Data entered in this field may include lowercase and 
uppercase letters (aBZz), apostrophes (’), commas (,), 
hyphens and periods (.), but cannot include underscores (_), 
numbers (0123), or special characters (ᴂ). 

b. Cell B1: Student First Name 

i. This field is required and cannot be blank. 

ii. Data entered in this field may include lowercase and 
uppercase letters (aBZz), apostrophes (’), commas (,), 
hyphens and periods (.), but cannot include underscores (_), 
numbers (0123), or special characters (ᴂ). 

c. Cell C1: Student Middle Name 

i. This field is optional because not all students have a middle 
name. However, it is highly encouraged and may reduce 
future work. 
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ii. Data entered in this field may include lowercase and 
uppercase letters (aBZz), apostrophes (’), commas (,), 
hyphens and periods (.), but cannot include underscores (_), 
numbers (0123), or special characters (ᴂ). 

d. Cell D1: Student Suffix 

i. This field is optional. 

ii. Data entered in this field may include lowercase and 
uppercase letters (aBZz), apostrophes (’), commas (,), 
hyphens and periods (.), but cannot include underscores (_), 
numbers (0123), or special characters (ᴂ). 

e. Cell E1: Date of Birth 

i. This field is required and cannot be blank. 

ii. Data in this field will be formatted in a later step. 

f. Cell F1: Multiple Birth Order 

i. This field is optional. 

ii. This field should be used when students are twins/triplets/etc. 
Students are designated by order of birth (enter “1” for the 
eldest child, “2” for the second-oldest, etc.) 

g. Cell G1: Gender Code 

i. This field is required. 

ii. The Gender data value must be M or F. The following values 
are invalid: 

1. f, m, female, male, fe, or ma (lowercase or uppercase). 
2. Numbers such as 0, 1, 2 or 3. 
3. Blank 

h. Fields in each row must contain a value, except for Student Middle 
Name, Student Suffix, and Multiple Birth Order (which can be blank). 

i. To check for blank fields, use Excel’s “Filter” utility under the 
“Data” tab. 

ii. Click the column arrow box to check if there are blank values in 
a column. (Note: Student Suffix is allowed to be blank, but 
required field columns should not show a “Blanks” option.) 
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i. Date of Birth must be formatted as yyyy-mm-dd. Highlight the 
column, right-click, and select “Format Cells…” 

 

i. In the text box that appears, select “Custom” from “Category:” 
ii. In “Type,” enter yyyy-mm-dd. 
iii. Click OK. 
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j. The dates should now be properly formatted for MSDS. 

 

2. Type Submitting Entity Code into cell H1. Select the entire column 
by clicking “H.” 
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a. Right-click and select “Format Cells…” 

 

b. In the window that appears, select “Text” from “Category:” (This will 
prevent Excel from removing leading zeroes from the entity code.) 

c. Click OK. 
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d. Enter your five- or nine-digit entity code for each row that you 
have data in the spreadsheet. To retrieve your entity code, search 
the Educational Entity Master. 

i. Enter the entity code in the first row of the “Submitting Entity 
Code” column. 

 

ii. To copy the code across cells, move the mouse pointer to the 
bottom right corner of the cell and hold down the right mouse 
button. 

https://cepi.state.mi.us/eem/
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iii. Keep the right mouse button pressed down and drag the mouse 
down the screen. When you reach the last cell, release the 
button. A context menu will appear. Click “Copy Cells.” 

 

The cell in each record will now be filled with the entity code. 

3. Type Submitting Entity Type Code into cell “I1.” 

 

a. The “Submitting Entity Type Code” field will differ depending on 
the entity type submitting for UICs. Characters in this field 
must be entered in uppercase. 

1. District authorized users with a 5-digit entity code enter: 
D 
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2. Entities with a 9-digit code enter: A 

ii. Right-click the bottom right corner of the cell. 

 

iii. Holding the button down, drag down to the last of the collection 
records. Then release and select “Copy Cells.” 

 

The cells will now be filled with the chosen character, such 
as “A” in the screenshot. 

 

4. Save the Spreadsheet in a secure area since it contains 
Personally Identifiable Information.  



K-12 Request for Unique Identification Code Bulk Upload Guide 

Page 14 

Step 3: Prepare the Data File (XML) 

This step will convert the Excel Spreadsheet into an XML file. 

1. Open a new, blank workbook in Microsoft Excel. 

 

2. Click the “File” tab on the top menu bar. 

 

a. Click “Options.” 
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b. The Excel Options window will appear. 

i. Select “Customize Ribbon” from the left column. 
ii. Select “Main Tabs” from “Customize the Ribbon:” 
iii. Check “Developer,” as shown in the following screenshot. 
iv. Click OK. 
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c. The menu at the top of the screen will now show the Developer tab. 
Click it. 

 

3. The Developer settings will offer options to convert a spreadsheet into XML 
format. 

a. Click “Source.” 
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b. The XML Source pane will appear on the right-hand side of the screen. 
Click the “XML Maps…” button near the bottom. 

 

c. In the new window that appears, click “Add.” 

 

d. Navigate to the schema you saved in Step 1. Click to highlight the XML 
file and then click Open. 
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e. Click OK. 

 

f. The XML Source pane will appear with a list of XML elements. 
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4. The next steps involve mapping XML data elements to the worksheet. 

a. Click the folder icon labelled SubmittingEntity in the XML Source list 
and drag it to cell A1. 
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b. Cells A1 and B1 should fill in with the text SubmittingEntityTypeCode 
for A1 and SubmittingEntityCode for B1. Expand the width of the 
columns to see the column headings more fully. 

 

c. Repeat these steps to drag the PersonalCore folder icon from the XML 
Source list into cell C1. 
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d. Cells C1, D1, E1, F1, G1, H1, I1, and J1 will fill with elements UIC, 
LastName, FirstName, MiddleName, StudentSuffix, DateOfBirth, 
MultipleBirthOrder, and Gender respectively. 

 

5. Add information for the XML header: 

a. Click the + icon at the bottom of the page to add a worksheet. 

 

b. Type the following information in column A, adding each item in a 
separate row: 

i. SchemaVersionMajor 
ii. SchemaVersionMinor 
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iii. CollectionID 
iv. CollectionName 
v. SubmittingSystemVendor 
vi. SubmittingSystemName 
vii. SubmittingSystemVersion 

 

c. Click “B” to highlight the column. 

d. Right-click “B” to bring up the context menu. Select “Format Cells…” 

 

e. Select “Text” from “Category:” and click OK. 

 



K-12 Request for Unique Identification Code Bulk Upload Guide 

Page 23 

 

f. In column B, enter the following information exactly: 

i. For Cell B1, enter: Collection 
ii. For Cell B2, enter: 5 
iii. For Cell B3, enter: 292 
iv. For Cell B4, enter: RequestforUIC 
v. For Cell B5, enter: Microsoft 
vi. For Cell B6, enter: Excel 
vii. For Cell B7, enter: 1.0 

 

6. To map XML header elements, drag XML Source items to these cells. 

a. Look for the RequestforUICGroup folder and drag the item 
SchemaVersionMajor to cell B1 where the word “Collection” appears. 
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If a message box pops up and states, “The data that you are 
attempting to map contains formatting that is incompatible with 
the format specified in the worksheet,” click the button marked 
Match element data type. 

 

b. The next XML Source item is SchemaVersionMinor. Drag it from the 
XML Source list to cell B2. 

 

c. Notice how the XML Source items have the same names as the text in 
column A. 

 

d. Drag the remaining items: CollectionName to cell B4, 
SubmittingSystemVendor to cell B5, SubmittingSystemName to cell 
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B6, and SubmittingSystemVersion to cell B6. 

 

Elements in column B will have a blue outline, and the elements in the 
XML Source list will appear in a bold font. 

7. The next task is to copy the student records from Step 2 into the mapped 
spreadsheet. 

a. Open the Excel spreadsheet with the student data. 

 

b. Highlight all the student last names, but do not include the header cell 
labelled “Student Last Name” with the selection. 
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c. Copy and paste the records into the XML data file directly below cell D1 
(marked “LastName”) on the first worksheet. 

 

d. Repeat this process for the remaining records. The column titled “UIC” 
should be left blank since this process is meant for obtaining UICs for 
students. 
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8. The last step is to finalize the new Spreadsheet with student data as an XML 
file. 

a. Select the Developer tab on the Excel menu. 

b. Click “Export.” 

 

c. Save the file in a secure location, as it contains Personally 
Identifiable Information. Ensure the Save as type is “XML Files.” 

d. Click OK. 

 



K-12 Request for Unique Identification Code Bulk Upload Guide 

Page 28 

Step 4: Upload the XML Data File to MSDS 

1. To upload the XML file created in Step 3, log into MSDS. 

a. Click “Student Data Submission…” to expand the menu. 

b. Click “Upload File.” 

 

2. Choose the XML file to upload. 

a. Select “Request for UIC Collection” for the “Collection.” 

b. Click in the empty Description textbox to automatically populate it. 

c. Click the Browse button. 

 

3. Another window will open. Navigate to the secure directory where your XML file is 
saved. 

4. Select your file and click Open. 
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5. Check the box marked, “Click here to receive a notification message when file has 
been processed” to receive an email when the upload process has finished 
(optional). Click “Upload File” to start uploading. 

 

6. The MSDS will process the file. If it is a large file, it may take a few minutes to 
upload. Click OK. 
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Step 5: Check the File Upload Status 

1. Click “Student Data Submission…” to expand the menu. Then click 
“Uploaded File Status.” 

 

2. Specify the collection you uploaded to 

a. Using the dropdown list, select the collection. 

b. Click “Filter.” 

 

3. MSDS will list the details of files that have been uploaded. In the screenshot below, 
the file displayed has a status that reads “Processing Detailed UIC Resolution.” This 
indicates that MSDS is still working to upload the file. 
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4. When MSDS finishes the upload process, one of two statuses will display. 

a. MSDS successfully processed the file, or 

b. The MSDS upload process failed. 

 

5. If the file upload failed, click the file name (underlined). 

 

6. MSDS will present the details for the file upload. When a file failed to upload, the 
details look like the following screenshot. 

a. The “Upload Status” describes the outcome of the file upload. 

b. MSDS offers clues to the failure in the “Records Contained” field. 
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c. To troubleshoot, please refer to the feedback (aka “Clues”). In the 
example shown, the MSDS is signaling a problem with two fields: 
SubmittingEntityTypeCode and SubmittingEntityCode. 

7. If the upload is successful, the MSDS will display the upload details. 

 

a. MSDS will display upload details in a separate window. The Status 
Description text and the Count of records resolved indicate the success. 
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Step 6: Recover UIC Assignment Details 

1. Matching results and assigned UICs can be retrieved after the MSDS uploads the 
XML file. 

a. From the MSDS main menu, click “Student Data Submission…” to expand 
the menu. Click “Data Staging Area.” 

 

2. On the following screen, select the collection from the dropdown list. Then click 
“Filter.” 

 

3. MSDS will list the file upload results. 

a. To view the results, click “Download.” 
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4. Click “Start Download.” 

 

5. A prompt will appear. To download a file with the results, click “To Downloads” 

 

6. A screen will open with the results for the Submitting Entity. The most recent 
upload will appear at the top of the list. In the following screenshot, there are two 
entries for the same file to illustrate how the MSDS will present the results. The 
status of the latest download will be: 

a. “File Generation in Progress” (these results cannot be accessed yet) 

b. “Ready for Download” (click the underlined link to download the file) 
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7. Extract the downloaded zip file. Right-click on the zip folder to bring up a context 
menu. Select “Extract All…” 

 

8. Select a location to extract the ZIP file to. 

a. Click the “Browse” button. 

 

9. Navigate to a secure location and click the “Select Folder” button. 



K-12 Request for Unique Identification Code Bulk Upload Guide 

Page 37 

 

10.Return to the previous screen with the destination file path displayed. 

a. Click the “Extract” button. 

 

11.Next, navigate to the folder you extracted the ZIP file in. 
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12.Start Microsoft Excel. Select the File tab. 

 

13.Select “Open.” Then click “Browse.” 

 

14.Navigate to the folder with the extracted ZIP file. 

a. Click the file to highlight. 

b. Click “Open.” 
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15.View the file “As an XML table.” Click “OK.” 

 

16.Navigate to Column J in the table to retrieve the UIC assignments for each 
student. 
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Step 7: Clear Staging Data 

As a final step, clear out the staging data. 

1. From the MSDS main menu. click “Student Data Submission…” Then select “Data 
Staging Area.” 

 

2. Enter your entity code and select the collection. Then click “Filter.” 

 

3. Once UIC information has been downloaded, there is no purpose retaining the 
records in the staging area. 

a. To clear staging data, click “Delete.” 
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4. A message box will appear asking for confirmation. Click OK.” 

 

5. The staging area will report the deletion. 
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